
Voorbeeldproject: eenvoudig instapproject

Als instapproject werken we het van uit. Dit model geeft een inzicht in de 
gereedschappen die vaak gebruikt worden, terwijl de complexiteit zeer laag blijft. Bovendien is het mogelijk om dit 
model op te bouwen aan de hand van bestaande plannen.

Deze plannen zijn hier onder te downloaden. Omdat de gratis versie van SketchUp het importeren van plannen 
niet (volledig) ondersteunt, is er een SketchUp bestand beschikbaar waar de plannen in geplaatst zijn.

SketchUp bestand in het 3D Warehouse tonen
(https://3dwarehouse.sketchup.com/model.html?id=u3d277d1f-33ed-4145-a3a7-
ebc485ac9657)

Het originele gebouw

Deze foto toont hoe het gebouw er in het echt uit ziet. Meer info kan gevonden worden 
op: http://en.wikipedia.org/wiki/Barcelona_Pavilion (http://en.wikipedia.org/wiki/Barcelona_Pavilion)

De basis

Barcelona paviljoen Mies van der Rohe
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Het bestand bevat een grondplan, een snede en een aanzicht. Dit zorgt er voor dat het werken vele malen sneller 
gaat. Als het bestand geopend wordt, ziet het er zo uit:

Selecteer eens één van deze plannen? Je ziet een rode selectiekader verschijnen. Dit wil zeggen dat de plannen 
geblokkeerd zijn: je kan deze niet aanpassen of verwijderen. Dit is gedaan zodat er niets kan mislopen.

Je kan de maat nemen op de plannen: daarvoor is er het gereedschap (het elfde gereedschap 
op de werkbalk).

De plannen zijn echter een verzameling van lijnen, en nog geen vlak waar op gewerkt kan worden. Om een project 
uit te tekenen, is de gemakkelijkste werkwijze een basis aan te maken. Er zijn twee mogelijke methoden:
-Je kan beginnen met de contouren van het plan na te tekenen met het 
-Het kan ook sneller: daarvoor is het gereedschap geschikt. Deze methode ligt niet iedereen, daarom is 
er de pagina tekenen met Rectangle (/tekenen-met-rectangle.html) die deze methode stap voor stap uitlegt

Welke methode ook gekozen wordt, dit is het resultaat:

Tape Measure Tool 

potlood.

Rectangle 
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Het gereedschap 

Goed. Dit is het grondvlak, nu dient dat een dikte te krijgen. Dit kan in slechts twee klikken met het gereedschap 
: het zesde gereedschap op de werkbalk.

Klik met dit gereedschap op het vlak om te starten. Door naar boven of onder te bewegen zien we dat het vlak een 
dikte krijgt. Hoe dik? Rechts onder zouden we een dikte van 1,2m in kunnen geven naar beneden. Maar omdat de 
plannen in dit model beschikbaar zijn, kan daarin met de muis een geschikt punt gezocht worden en op geklikt 
worden:

Push/Pull

Push/Pull
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Ook de muren worden zeer snel met vorm gegeven.
Ga met het gereedschap over de plaatsen waar muren dienen te komen.
Daarna kunnen deze met Push/Pull een hoogte gegeven worden van 3,1m.

Push/Pull

Rectangle 
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Doe dit voor alle muren.

Hier en daar blijven er lijnen staan. deze kunnen met de gum verwijderd worden. Mocht je per ongeluk verkeerde 
lijnen verwijderen, kan je dat altijd ongedaan maken via het menu .

Fantastisch hoe snel alle muren getekend zijn!
De vijvers zijn identiek hetzelfde. Maar dan in plaats van deze omhoog te trekken, zoals met de muren, duwen we 
deze 0,5m .
Dit gebeurt ook weer door eerst met het op de juiste plaats lijnen te trekken, en daarna het vlak in te 
duwen met . Doe dit voor beide vijvers.

In de grootste vijver zien we één verticaal lijntje te veel verschijnen. Zoek dit, en verwijder dat. SketchUp tekent dit 
lijntje overal waar er meerdere lijnen samen komen omdat daar een knooppunt ligt.

Divide line

Om de trap te tekenen kan uit het hoofd uitgerekend worden hoe lang elke trede dient te zijn, ofwel laten we dit 
door SketchUp doen. Teken hiervoor een lijn aan de linkerzijde van de trap, recht omlaag over de volledige lengte 
van de sokkel. Zo hoog wordt de trap, en deze hoogte moet verdeeld worden over het aantal treden. Door 
rechtermuisklik -> Divide wordt een lijn in onderdelen verdeeld. Door over de lijn te bewegen is het aantal 
onderdelen te bepalen en krijgen we tevens de lengte van elk onderdeel. Ofwel kan er rechts onder een 
hoeveelheid ingegeven worden. Onze lijn dient in 8 onderdelen verdeeld te worden omdat de trap 8 keer omhoog 
gaat (aantal treden+het bovenvlak). Het resultaat komt mooi uit: 0,15m per onderdeel.

Edit -> Undo

omlaag

Rectangle 

Push/Pull
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Het is niet direct zichtbaar dat de lijn onderverdeeld is in 8 onderdelen, maar het potlood weet dit als je over de 
lijn beweegt. Trek zeven horizontale lijnen zoals op onderstaande tekening:
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De vlakken die nu op de zijkant van de sokkel getekend zijn, kunnen met zeer eenvoudig ingeduwd 
worden tot de juiste lengte, aangegeven door het grondplan dat op het voetstuk ligt.

Push/Pull
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Draai het model even: aan de andere kant van de trap verschijnen er lijnen. Deze mogen gewist worden met de 
gum, evenals het resterende lijntje onderaan de trap.

Het gereedschap 

Het gereedschap kan als achtste in de werkbalk gevonden worden. is het Engelse woord voor 
, en dat is ook letterlijk wat dit gereedschap doet:

-Als er niets geselecteerd is, dan wordt verplaatst;
-Als er een selectie actief is, dan worden verplaatst.

Probeer dit uit op bijvoorbeeld een muur. (Ongedaan maken kan in het menu 

Dit gereedschap is handig om bijvoorbeeld de vijvers af te werken. Op de plannen is te zien dat er een stippellijn 
getekend staat; de tegels hangen over een afstand van 0,3m over het water heen.

Omdat er reeds veel lijnen getekend zijn, kunnen we deze hergebruiken. Met het selectiegereedschap selecteren 
we de twee lijnen onderaan de grote vijver. 

Move

Move Move 

verplaatsen

het aangeklikte object

de geselecteerde onderdelen

Edit -> Undo.)
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Als we op deze selectie klikken met het move-gereedschap, dan zien we dat het model raar zal doen. We willen 
deze lijnen echter niet verplaatsen, maar hergebruiken door te kopiëren.
Dit kan door op het toetsenbord even in te drukken. Wat het gereedschap nu doet, is de bestaande 
lijnen met rust laten, en . Verplaats deze lijn recht omhoog over een afstand van 0,45m.
Hierdoor wordt de dikte van de vloer aangegeven.

control Move 

een kopie verplaatsen
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Alles wat onder deze vloer ligt kan met het gereedschap ingedrukt worden over een afstand van 0,3m, 
tot de vlakken gelijk liggen met de stippellijnen.

Push/Pull
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Doe dit ook voor de kleine vijver.

Het gereedschap 

Om de eerste pagina af te sluiten wordt er dieper ingegaan op het zevende gereedschap op de werkbalk, 
genaamd . Wat het gereedschap doet, is de contouren van een vlak overnemen, en deze over een 
bepaalde afstand verleggen.

Dit komt in ons model van pas voor de twee kortste muren binnen in het gebouw. Deze muren zijn bovenaan 
versmald, om esthetische redenen. Zorg dat er geen actieve selectie is in het model. Kies daarna het gereedschap 
Offset, en beweeg naar de bovenkant van deze muren totdat deze geselecteerd wordt. Klik hier nu op, en sleep 
met de muis. Hierdoor is er te zien wat er zal gebeuren: de contouren van het vlak worden verlegd. Typ het getal 
0,04m in, naar de binnenkant van de muur.
Het resultaat is een rechthoek boven op de muur. Alles wat buiten deze rechthoek ligt, kan met het gereedschap 
Push/Pull 0,04m omlaag gebracht worden. Doe dit ook op de andere muur, en dit is het resultaat:

Offset

Offset Offset 
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Als dit allemaal getekend is, vergeet niet om het model op te slaan! Hiervoor is er het menu . Kies een 
locatie op de computer die gemakkelijk terug te vinden is.

Daarna kan je doorgaan naar pagina 2 (/voorbeeldproject-met-plannen-p2.html).

File -> Save

UTM_SOURCE=INTERNAL&UTM_MEDIUM=FOOTER&UTM_CAMPAIGN=3)
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Voorbeeldproject: Barcelona Paviljoen, p2

Op deze pagina wordt het model afgewerkt dat op pagina 1 (/voorbeeldproject-met-plannen.html) aangevangen 
werd.

Werken met groepen

Op pagina 1 werd een mooie basis opgebouwd. Stel nu dat er een muur verplaatst dient te worden omdat deze 
niet op zijn plaats staat: probeer dat eens op dit model.
Je hebt al vlug één zijde van de muur vast, terwijl de rest blijft staan. Het zou vele malen handiger zijn als je met 
één klik de volledige muur kon oppakken. Hiervoor bestaan er in SketchUp . Een groep is 

die samen een geheel vormen, en die samen verplaatst zullen worden.

Om een groep te maken is enkel het selectiegereedschap nodig.
Onthoud voor dit gereedschap:
-Eén keer klikken selecteert de onderliggende lijn of vlak.
-Twee keer klikken selecteert het onderliggende lijn of vlak, samen met zijn aangrenzende lijnen en vlakken.
-Drie keer klikken selecteert alles wat verbonden is met het element onder de aanwijzer.

Klik drie keer op onze tekening. Alles wordt geselecteerd, maar merk op dat het plan niet mee geselecteerd wordt. 
Dit komt omdat dit reeds een groep is. Om nu een groep van de selectie te maken,  .

groepen een verzameling 

van vlakken en lijnen

rechtermuisklik -> Make group
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Een groep heeft een andere soort selectie om zich heen: een blauwe box. Dat maakt gemakkelijker om groepen te 
herkennen. Wij hebben een groep gemaakt van onze basis, alles wat we hier op zullen plaatsen zal gemakkelijk te 
positioneren zijn.

Vanaf nu beginnen we aan de daken: trek een rechthoek over de stippellijnen heen. Geef deze met een 
hoogte van 0,24m. Driedubbel klik op dit volume, en maak er een groep van:

Push/Pull
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Gebruik het gereedschap Move om het dak op zijn positie te plaatsen, op de muren. Merk op hoe gemakkelijk dit 
gaat, omdat alles is ondergebracht in groepen. Zorg dat je het dak verplaatst volgens de (loodrecht 
omhoog). Nogmaals: als je eenmaal volgens een as aan het verplaatsen bent (je ziet de as), en je houdt daarna 
shift in op het toetsenbord, dan zal SketchUp niet meer van deze as afwijken.

In een goed opgebouwd model zijn alle onderdelen ondergebracht in een groep. Hierdoor wordt het werken 
gemakkelijker.

Plaats boven op dit net getekende dak nog een rechthoek die even groot is. Dit zal de dakbedekking worden. Geef 
deze rechthoek met een hoogte van 0,08m, en rek al de zijkanten 0,02m uit over het vorige dak. Maak 
ook hier van een groep.

Als dit gebeurd is, wordt met het selectiegereedschap beide dakonderdelen geselecteerd. Maak hier nogmaals een 
groep van. Hierdoor hebben we twee groepen in één grote groep. Het resultaat is dat als dit onderdeel verplaatst 
wordt, de beide groepen tegelijk bewegen.

blauwe as

Push/Pull
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Doe dit ook voor het andere dak, en voor de zitbank.
-De maten van de zitbank kunnen op de sneden afgelezen worden.
-Het andere dak bevat een dakraam. Dit raam is even groot als de gesloten rechthoek in het grondplan.

Slimme groepen: componenten.

Het laatste onderdeel dat wij zelf zullen tekenen zijn de ramen. Deze herken je op het grondplan als zeer dunne 
constructies. Elk raam zal individueel getekend worden, en om hier aan te beginnen, wordt een rechthoek 
getekend van het ene einde tot het andere.
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met Push/Pull kan deze rechthoek uitgerokken worden tot tegen het dak.
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Met het gereedschap wordt een kader getrokken op 0,04m van de rand, en met het gereedschap 
wordt de binnenkant door het volume heen getrokken, tot tegen de achterzijde, waardoor een opening ontstaat. 
Selecteer de volledige raamkader, en maak hier een groep van.

Offset Push/Pull
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Trek daarna een rechthoek over deze opening, maak van deze rechthoek een groep, en plaats deze in het midden 
van de kader. Dit zal het glas worden. NOOT: dit glas mag een dikte gegeven worden, maar dat is niet noodzakelijk 
in zulks een eenvoudig model als dit.
Dit is de basis van de ramen. De meeste mensen zullen nu braaf een groep willen maken van het raamkader én 
het glas. Er is echter nog een andere optie: een component.
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Een component is bijna hetzelfde als een groep, maar is intelligent. Dit wil zeggen: als je een component meerdere 
malen gebruikt, en je past er één van aan, dan zullen alle componenten in je model aangepast worden. Dit komt 
van pas zodra we de ramen kleur gaan geven.
Stel dat we van de ramen een groep maken, dan dienen we straks alle ramen te schilderen. Als we met 
componenten werken, is er slechts één raam te schilderen, en de andere ramen zullen zichzelf aanpassen.

Gebruik het gereedschap in combinatie met de toets om de overige ramen te plaatsen.
Een deel van de ramen staat onder een andere hoek. Dit kan met het gereedschap  opgelost worden. Dit is 
het negende gereedschap op de werkbalk.

Voor de bredere ramen (herkenbaar op het grondplan), dient er een nieuw component opgebouwd te worden. Dit 
kan op dezelfde manier als de vorige ramen opgebouwd zijn. Ten slotte zijn er acht kolommen aanwezig in dit 
gebouw. De opbouw van deze kolommen is identiek als deze van de ramen.

3D Warehouse in SketchUp

Standbeelden worden vaak in specifieke programma's gemaakt, en daarna omgezet in een SketchUp bestand. Om 
het standbeeld van dit model te plaatsen, zoek je het op in het . Dit kan via in het menu 

.

Move control 

Rotate 

3D Warehouse Window -> 

Components
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Voor ons zijn er twee knoppen van belang: de knop met het huis op, dan worden alle componenten getoond die 
zich in het model bevinden. En de zoekbalk, welke alle mogelijke resultaten uit het 3D Warehouse zal tonen (een 
internetverbinding is hiervoor vereist).

Door in de zoekbalk te zoeken naar   krijgen we een kant-en-klaar standbeeld dat te 
downloaden is door op de afbeelding te klikken.

TIP: alle voorwerpen die gevonden worden in het 3D Warehouse dienen met een korrel zout genomen te worden. 
Dit standbeeld is daar een voorbeeld van. Het originele model van  is geschikt, maar er zijn fouten in 
terug te vinden (het is onder andere 10x te klein. Daarom heeft de auteur een aangepaste versie online geplaatst. 
Probeer beiden uit om het verschil te zien.

Ook de stoelen, genaamd kunnen in het 3D Warehouse teruggevonden worden, evenals personen 
om het gebouw te bevolken.

Het gereedschap 

Als er bijvoorbeeld een object uit het 3D Warehouse gedownload is, dat veel te klein is, dan is dat met het 
gereedschap te corrigeren. Of zoals op onderstaand voorbeeld: de hoogte van mensen aanpassen.

Kleuren en texturen

Kleuren en texturen zijn aan te brengen met het gereedschap , het dertiende icoon in de werkbalk.

Het werkt zeer eenvoudig: in het palet dat verschijnt wordt een geschikte kleur/textuur gekozen. In het model 
krijgt het vlak waar we nadien op klikken deze kleur/textuur.
Let even op met groepen en componenten: deze worden in hun geheel geverfd. Om daar slechts één vlak van te 

barcelona pavilion statue

Xray Haller

Barcelona Chair

Scale

Scale 

Paint Bucket
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kleuren, dien je de groep te bewerken door er op te .

Geef het model kleur.
-Kies donker grijs voor de bovenste laag van het dak.
-Kies een kiezel voor de onderkant  van de vijvers.
-Kies een metalig grijs voor de raamkaders en zuilen.
-Kies een transparante kleur voor de ramen.

Ten slotte: om water in de twee vijvers te leggen:
-Teken een rechthoek op de bodem van de vijver en maak hier een groep van.
-Geef deze de textuur van water met het gereedschap .
-Trek deze rechthoek met het gereedschap 0,2m naar boven.
-Gebruik het gereedschap opnieuw om deze rechthoek nogmaals 0,1m naar boven te kopiëren.
   Door deze tweede laag water wordt het water troebeler, wat vaak een beter beeld geeft.

Het is mogelijk om texturen van afbeeldingen te importeren.
Op deze site (http://benv2423-daminyan.blogspot.be/2012/11/textures-for-barcelona-pavillion.html) zijn een 
aantal materialen van het paviljoen omgezet in een textuur, en via zoekmachines zijn er nog meerdere te vinden.

Afsluiter

Dit is een bestaand gebouw, dus het kan geo-gepositioneerd worden met behulp van Google Maps. Dit wordt in 
de les voorgedaan. Hierdoor komt er een nieuwe ondergrond in het model.

Het model is correct opgebouwd met groepen en componenten. Lees de uitleg over werken met lagen (/werken-
met-lagen.html). Je merkt dat de plannen in dit model reeds in een laag staan, evenals de ondergrond die uit 
Google Maps geïmporteerd is. Zij zijn dus onzichtbaar te maken. Zet daarna alle personages, alle eventuele maten 
of alle planten die je toevoegt in een aparte laag.

Uiteindelijk ziet het lesmodel er als volgt uit:

rechtermuisklikken -> Edit Group

Paint Bucket

Move 

Move 
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Om jouw eigen model te vergelijken met het lesmodel is dat hier te downloaden.

Een extra die je meekrijgt: het is mogelijk door het model te wandelen. Je kan dit met de hand doen, maar in dit 
model dat je download is dat ook mogelijk door het menu .
Er verschijnt een start en stop knop, terwijl de computer een voorgedefinieerd traject begint te wandelen.
NOTA: op trage computers zal het even duren eer dit traject gestart wordt.

Bekijk het model in het 3D Warehouse
(https://3dwarehouse.sketchup.com/model.html?id=u831af29b-4dd8-477a-9be2-1738f015492d)

View -> Animation -> Play
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